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Welcome to Perfect Effects 1

Welcome to Perfect Effects

Bring out the “WOW” in your images with the transformative power of Perfect Effects 8. Its extensive library of oneclick presets, adjustable filters, and
powerful tools make it easy to bring out the best in your image. Get stunning results instantly or take complete creative control as you add subtle to striking
enhancement to your image, create a vision that you have in your mind's eye, or immerse yourself in freeform creativity. With Perfect Effects 8, you can do
it all
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Introduction
This introductory chapter includes general helpful information about how to use this help system, how to contact onOne Software, how to install and access the
software, etc. It covers many of the foundation topics that you will need to understand to get started.

Pages in this Section
Using the Help System
Contacting onOne Software
Additional Help
System Requirements
Installation
Licensing and Registration
Opening and Saving Files
Using Modules
Using as Standalone
Using with Adobe Photoshop
Using with Adobe Lightroom
Using with Apple Aperture
Using with Other Applications
Managing Extras
Preferences
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Using the Help System
This user guide is html based and readable in most web browsers. On the left side, you will see a table of contents that make it easy to find the section you are
looking for. The table of contents is hyperlinked and will take you to the specified section by clicking on them. The main body of the page will show you the
content you have requested. Use the scroll-bar at the right to scroll down for additional content. You may see hyperlinks in the body text. They will be blue and
underlined. Clicking on one of these hyperlinks will take you to more relevant information.
You use the same forward and back buttons in your browser to navigate this user guide as you would a regular web page. You can even bookmark pages so
you can find them quickly later.
If you don't see what you are looking for in the table of contents, try the search field at the upper right. You can type in what you are looking for and an index
of pages will be created automatically that contain your search term.

Printing the Manual
You can print individual pages by pressing the Print button at the top of the page. A complete printable PDF version of this user guide is available in the user
guide section of the onOne website. This version may be downloaded and viewed when you do not have an internet connection. The PDF version may also be
installed on your tablet or eReader device for viewing off our computer.
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Contacting onOne Software
At onOne Software, we value our customers and offer a variety of ways to be contacted.
• Visit our company website at:
www.onOnesoftware.com

• For technical support please visit:
www.onOnesoftware.com/support

onOne Software, Inc.
15333 SW Sequoia Parkway Suite 150
Portland, OR 97224
Telephone: 503-968-1468
Fax: 503-968-1469

© 20072014 onOne Software, Inc. All rights reserved. onOne Software is a registered trademark of onOne Software, Inc. The onOne Software logo are trademarks
of onOne Software, Inc. Adobe, Photoshop, Photoshop Elements, Lightroom are either registered trademarks or trademarks of Adobe Systems, Incorporated in the United
States and/or other countries. Mac OSX, the Mac logo, iPhoto and Aperture are trademarks of Apple, Inc., registered in the U.S. and other countries. Microsoft, Windows
7, Windows 8 are registered trademarks of Microsoft Corporation. All other trademarks are the property of their respective owners. The activation system used
by onOne Software, Inc. is licensed under Patent No. 5,490,216. For a full list of license disclosures view the LICENSE.TXT file installed with the software.
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Additional Help

Technical Support
Contact technical support at www.ononesoftware.com/support or by filing out a request form.

Knowledge Base
Search the Knowledge Base for common issues, tips & tricks, and compatibility questions.
Frequently Asked Questions
Check the list of Hot Topics on the onOne web site. This covers the most frequently asked questions.

Video Tutorials
Visit the onOne University for free online video tutorials and archived webinars. Many users find these to be the best and fastest way to get
started and learn new techniques.
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System Requirements

Operating
System

Minimum
Mac OSX 10.7, 10.8, 10.9
Windows Windows 7 or Windows 8
current maintenance releases, 64 bit only

Processor

Intel Core 2 Duo, Xeon or better processor(s)

RAM

8 GB RAM

Hard Drive

1 GB for installation

Display
Optional
Application
Integration
Other

OpenGL 2.0 compatible video card with 256 MB
dedicated video RAM, 1280x720 resolution
Photoshop CS5, CS6, CC, CC 2014
Photoshop Elements 10, 11, 12
Photoshop Lightroom 4, 5
Apple Aperture 3.4
Internet connection for activation, auto update
checking, content downloads and tutorials.
Adobe Flash Player

Recommended
Mac OSX 10.8, 10.9
Windows Windows 7 or Windows 8
current maintenance releases, 64 bit
Quad-core Intel Core i5, Xeon or better
processors(s)
8+ GB RAM
1 GB for installation
Fast 7200 RPM or SSD drives
OpenGL 4.0 compatible video card with 1GB
dedicated video RAM, 1920x1080 resolution
Photoshop CS6, CC, CC 2014
Photoshop Elements 11, 12
Photoshop Lightroom 5
Apple Aperture 3.4
Wacom tablet for pressure sensitive input
Hardware display calibration tool

About Windows Video Cards
If you are using Perfect Effects from a Windows based computer, it is important that you have the latest drivers for your video card installed to get the best
performance. Check with your video card manufactures website for the latest drivers. Be sure your video card is OpenGL 2 compliant and has 256MB or more of
dedicated VRAM. Many integrated video cards on low-end laptops may not meet these requirements.
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Installation
To install Perfect Effects, double click the installer icon and allow the installer to guide you. You may have downloaded the installer from the onOne Software
website or it may be on a DVD if you elected for a physical shipment.

You should close any supported host applications such as Photoshop, Lightroom or Aperture as well as any standalone versions of
onOne products before installing or updating.

Mac OSX
The application is installed in the Perfect Effects folder in the Applications folder.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Effects is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folder.
Windows
The application is installed in the Perfect Effects directory in the onOne Software directory in the Program Files directory.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Effects is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into \ProgramData\onOne Software\.

Uninstalling
To uninstall Perfect Effects, follow these instructions.
You should deactivate your product before uninstalling. This will allow you to transfer your license to another computer.

Mac OSX
1. Go to the Applications/Perfect Effects/Documentation folder.
2. Double click on the Remove Perfect Effects application.
Windows
1. Go to Control Panels.
2. Under Programs select Uninstall a program.
3. In the list that comes up select Perfect Effects and then click on the Uninstall button.
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Licensing and Registration
Perfect Effects will operate as a trial version for 30 days from when it is installed. If you have purchased Perfect Effects, you will want to license it so you can
continue to use it past the trial period. When you install Perfect Effects it will prompt you to license it. Simply click on the license button and enter your license
code. Your license code can be found in your order confirmation email if you purchased the download version directly from onOne Software. If you purchased a
physical copy of Perfect Effects, a sticker on the information card will have the license code on it. Your license code allows you to install Perfect Effects on two
computers. When you enter your license code, Perfect Effects communicates with the onOne activation server and will activate your software. Your software
must be licensed and activated to function past the trial period. If the computer you are activating does not have access to the internet, you can manually
activate your software by following the manual activation instructions in the license dialog.
If you wish to move your copy of Perfect Effects from one activated computer to new computer you will need to deactivate it first. Deactivation is a simple
process. Simply open Perfect Effects and select Deactivate from the Help menu. This will deactivate Perfect Effects on the current machine, allowing you to
install and activate it on another machine.
If you lose your activation code, have your computer stolen and can not deactivate it, need to install on more than two computers or have other activation
issues please contact onOne customer service at 1-888-968-1468 or visit the support section of the onOne software website.
It is important to register your copy of Perfect Effects if you did not purchase it directly from onOne Software, so we can provide you with the best possible
service. Registered users of Perfect Effects are eligible for free technical support, information regarding new versions and products, free updates, upgrade
pricing and special offers on new products.

Product Improvement Program
We believe that the best products are made by listening to our customers. We use many methods to gather your ideas and feedback including: emails, surveys,
direct conversations, market analysis and the Product Improvement Program. The Product Improvement Program is built into our software and gathers
information about how our software is used. It is the most accurate way for us learn what features are important to you and how our products fit into your
workflow.
Enrollment in the program is voluntary. When you participate, we collect basic information about how you use our programs and basic information about your
computer. This information helps us learn what features are important to you and how we can make our software easier to use. No personal information is
collected and you will not be contacted.
You can choose to participate in the Product Improvement Program the first time you launch an onOne product. You can change your participation later, just
click the Help menu, then Help Improve onOne Products.
You can learn more about the Product Improvement Program here.
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Opening and Saving Files

Supported File Types

Perfect Effects uses the Photoshop (PSD) file format as its default file type. The Photoshop file format is a commonly supported, publicly documented file format
that is also the standard file for Adobe Photoshop. It is also supported by Photoshop Elements, Lightroom, Aperture and many other image editing applications.
It supports multilayered images and layer masks making it the perfect format for durable, adjustable imaging. Perfect Effects also supports the opening and
saving of the following file types, in RGB either 8 or 16 bits per pixel.
Photoshop (PSD)
Photoshop Large Document (PSB)
Tagged Image File Format TIFF (TIF)
Joint Photographic Experts Group JPEG (JPG)
Portable Network Graphic (PNG)
Camera Raw files from over 200 digital cameras
Photoshop PSD files will maintain all the layers and layer masks you create in Perfect Effects and are recommended as your main file format. If your saved file
will be larger than 2 GB or 30,000 pixels on a side, your image will automatically be saved in the .PSB or Large Document format. This is a newer version of the
PSD file format and still maintains all your layers and masks.
You can use the Edit a Copy or Save As command to save flattened TIF and JPG files or PNG files with transparency. Camera raw files can only be opened, not
saved directly. They must be saved as another file type.

Opening Files
You may open an existing file in several ways.
1.
2.
3.
4.

Selecting a file(s) in the Browse module, then clicking on another module, like Layers or Effects.
Open the file from the File > Open menu if you are using the Layers module.
Dragging a file onto the Perfect Effects icon.
Sending a file to Perfect Effects from a host application like Photoshop or Lightroom using the Perfect Effects plug-in.
When opening an existing PSD file that has been editing in Photoshop it may contain unsupported layer types such as text layers, adjustment
layers, etc. you will see a warning. You can still open a flattened version of the image if this happens. You can learn more here.

Opening Options
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When you open a file(s) in the standalone application you will be presented with the
dialog to the right. It allows you to choose to work on the original file, a copy, or to
stack the files together as layers.
Edit a Copy: A copy of the original file is made using the Copy Options below
and saved in the same folder as the original.
Edit Original: The original file is edited directly. This overwrites the original file
with your changes. This option is disabled for Raw or read-only files.
Add as a Layer: The original file is added as a layer(s) into the current image
in Perfect Layers. If no image is opened, a copy of the first image in your
selection is created.
If you select to open a copy, you can control the file type, color space, bit-depth and
resolution. If you have multiple files selected, they will all be handled the same way.

Saving Files
1. You may save the open file using the save option command in the Layers module anytime.
2. If you opened your image from the Browse module, simply return to Browse to save and close the file.
3. If you have accessed Perfect Effects using a plug-in from another application, follow the instructions from that application for saving.
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Using Modules
Perfect Effects is a complete photo editor. It uses a modular approach, allowing each module to focus on one task. This makes accomplishing the task easier by
removing unnecessary tools and giving access to just what you need to get the task done. When used as a standalone application, Browse is the default module
upon first launch, it is used to navigate your drives and cloud services to find images to begin working. In the Preferences you may change the default startup
module to Perfect Layers. If you prefer a layered workflow you can use the Layers module as the heart of your workflow, similar to using Adobe
Photoshop. Depending on how you access Perfect Effects you may never notice Browse or Layers.

The Module Selector
If you access Perfect Effects as a standalone application you will start in
Browse or Layers module.
When you are ready to edit an image you will select the module you wish
to use from the Module Selector in the upper right corner of the main
window. You can easily switch between modules by clicking on another in
the Module Selector. This allows you to perform multiple tasks during the
same editing session.

This is the module selector from the Perfect Photo Suite. It contains all of the
available modules that onOne Software makes. If you have purchased a single
product, you will only see that product module and Perfect Layers in your module
selector.

When you have completed your work, you return the Perfect Layers
module to save your work.
If you access Perfect Effects as a Photoshop Plug-in you see the Module selector, but it will be disabled, you can only use one module at a time through
Photoshop. The Module Selector will also be disabled if you use the following modules through Lightroom or Aperture:
Perfect Portrait
Perfect Effects
Perfect B&W
Perfect Enhance
Perfect Resize
When you access these modules, you use them on their own and then return back to Lightroom or Aperture directly. Your file will be saved and closed
automatically. If you access Layers or Mask through Lightroom or Aperture you will start in the Layers module.

If you want to have access to all your modules during an editing session from Lightroom or Aperture, select the Perfect Layers plug-in. This will start
you in Perfect Layers and the Module Selector will be visible, allowing you to access all of the installed modules.
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Using as Standalone
Perfect Effects can be used as a standalone application without the need of Photoshop, Lightroom or other host application. To launch it follow these steps:

Mac OSX
1.
2.
3.
4.

Open your Hard Drive.
Navigate to the Applications folder.
Navigate to the Perfect Effects folder.
Double click on the Perfect Effects application icon.

You can add Perfect Effects to your dock for easy access by clicking and holding the icon in the dock, then select the Keep In Dock option. If you use Launchpad
it can be found there as well.

Windows 7
1. Go to your Start Menu.
2. Select the onOne Software group.
3. Select Perfect Effects.
If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Effects from there.

Windows 8
1. Open the Start screen by pressing the Window key.
2. Select Perfect Effects.
If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Effects from there.

Perfect Effects

Introduction 13

Using with Adobe® Photoshop®
If you have the Premium Edition of Perfect Effects, you can access it as a plug-in through Adobe® Photoshop® or Photoshop® Elements®. This
includes the onOne panel for Photoshop for fast access to plug-ins and their presets. As a Photoshop plug-in you can use modules in the Photoshop
workflow. This includes using selections and masks as well as Smart Objects and Smart Filters. You can also record actions for automating and batch
processing.
If you do not have the Premium Edition of Perfect Effects and would like to use it inside of Photoshop, contact onOne Customer Service about
upgrading to the Premium Edition.

To use Perfect Effects inside of Adobe Photoshop
follow these steps:
1. Open the image you want to work on.
2. Select the layer you want to work on.
Generally Perfect Effects works on a copy of
your selected layer, not the entire image.
3. From the File menu, select Automate, and
then the module you would like to use.

To use Perfect Effects inside of Adobe Photoshop
Elements, follow these steps:
1. Open the image you want to work on.
2. Select the layer you want to work on.
Generally Perfect Effects works on a copy of
your selected layer, not the entire image.
3. From the File menu, select Automation Tools,
and then the module you would like to use.

Perfect Layers and Browse are not accessible from Adobe Photoshop or Photoshop Elements.

You can use the for Adobe Lightroom and Apple Aperture Edition inside of Adobe Photoshop Elements as well.

onOne Panel
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Users of Adobe Photoshop CS5 and higher can also access Perfect Effects as plug-ins using
the onOne Extension Panel. This provides fast access to the Perfect Effects and its presets.
To access the onOne panel, go the Window > Extensions menu in Photoshop and select
onOne.
The onOne panel behaves just like any other panel in Photoshop. It can be minimized or
nested with other panels. To access a module, simple double-click on it. To use a preset,
single click on the module name. A menu of available presets will be displayed. Simply doubleclick on one to apply it to your selected layer.

If you wish to record actions using Perfect Effects be sure to access it from the
File > Automate menu when recording.

Perfect Effects
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Using with Adobe® Lightroom®
If you have the Premium or for Adobe® Lightroom® & Apple® Aperture® version of Perfect Effects you can access Perfect Effects as a plug-in
inside of Lightroom. This provides an integrated, round-trip workflow.
Perfect Effects is the perfect companion for Adobe Photoshop Lightroom. It integrates tightly with it and provides a seamless experience for
enhancing your images. There are several ways to use Perfect Effects with Lightroom.

Plug-In Extras
Perfect Effects can be accessed from the File >
Plug-in Extras menu. This is the preferred way to
access it. It gives you access to all installed
modules and has the most flexibility in how the files
are handled. To edit an image in Perfect Effects
follow these steps.
1. Select the image in Lightroom.
2. Go the File menu and select the Plug-In
Extras flyout.
3. Select the module you would like to use.
When you access Perfect Effects as a plug-in from
Lightroom the module selector is only available for
Perfect Layers or Perfect Mask. When you select
one of these modules you can use as many
modules as you desire during the same editing
session. At the end of the editing session you must
save and close the image from the Perfect Layers
module.
When you select a module other than Perfect
Layers or Perfect Mask your image will be sent to it
directly and when you press Apply, the image is
saved and closed automatically and you are
returned back to Lightroom.
Selecting Multiple Images
If you have multiple images selected, the behavior
varies depending on which modules you select.
Perfect Layers or Perfect Mask: Each file
will be opened in its own tab. Then you
may access any modules available in the
Module Selector.
All other plug-ins: Each image is opened in
turn and you may adjust the settings on an
image by image basis.

Lightroom Plug-in Preferences
When you use Perfect Effects through the Plug-In Extras menu there are
important file handling options that are controlled in the Preferences dialog of the
Perfect Layers module. These need to be configured in advance based on your
desired workflow.
File Type: The file type drop-down menu determines what type of file will
be created. The default is PSD, which maintains layers. You can also select
JPG or TIF if you prefer those formats and are not concerned about
maintaining layers. The last option is same as source, which maintains the
file type of the original file, except for Camera raw files which are saved as
PSD.
Color Space: The color space drop-down menu determines what RGB
working color space is used; Adobe RGB 1998, sRGB or ProPhotoRGB.
Bit Depth: The bit-depth drop-down menu determines the bit depth,
either 8-bit or 16-bit per pixel.
Resolution: The resolution drop-down menu determines the resolution of
the file.
Stack with Original: When enabled, the new image is stacked with the
original image, making it easier to organize.
Use Original for Single PSDs: When enabled, if you select a single PSD
file, it will be edited directly, rather than having a copy made.

External Editor
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You can also access modules as
external editors for all modules
except Perfect Layers or Perfect
Mask. You can access them from
the Edit In... contextual menu.
These behave similarly to the
plug-ins in the Plug-In Extras
menu but ignore the preferences
set in Perfect Layers. Instead
you have the option to control a
subset of these options each time
you access a module, in the same
way you do when you access
Photoshop or any other external
editor.

Batch Processing
There are two ways to batch process multiple images in Lightroom with Perfect Effects.

Perfect Batch
Perfect Batch is the preferred way to batch process. You start with a selection of
images in Lightroom or folder on disk, then batch-process them with multiple modules
at the same time to solve complex workflows. For example a portait photographer
can prepare images for a sales session by retouching every face, adding their
stylized look and output small JPGs with their logo watermark, all in the same batch
process. You can access Perfect Batch from the File > Plug-In Extras menu in
Lightroom. You can learn more about using in the Perfect Batch section of this user
guide.
Key batch processing features include:

Start with a selection of images from Lightroom or any folder
you select.
Batch process with a single module for simple jobs or create
workflows where you string multiple modules together.
Save workflows to use over and over.
Pause on the first image to confirm your set-up, then
automatically process the rest to match.
Add a visual watermark, like your logo, to every image.
Edit files in place or create new files with different size, name or
file type.

Lightroom Export
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You can also batch process with a single module
through the Export menu in Lightroom. This is useful if
you need to remove metadata or are more
comfortable with Lightroom's Export. Batch processing
through Export is driven by presets, so you need to
create a preset that accomplishes the work you desire
first.
1. Select the images you wish to batch process.
2. Go the Export under the File menu.
3. At the top under the Export to drop-down,
select the module to use.
4. Complete the module specific options below.
These will start with the preset, followed by
options for selecting the export location, file
naming, file size, etc.
5. Press the export button.

You cannot save Lightroom export
presets or use the Export with
Previous option.
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Using with Apple® Aperture®
If you have the Premium or for Adobe® Lightroom® & Apple® Aperture® Edition of Perfect Effects you can access Perfect Effects as a plug-in inside
of Aperture. This provides an integrated, round-trip workflow.

Perfect Effects integrates tightly with Apple Aperture and provides a seamless
experience for enhancing your images.
Perfect Effects can be accessed from the Photo > Edit with Plug-In menu. To
edit an image in Perfect Effects follow these steps.
1. Select the image in Aperture.
2. Go the Photo menu and select the Edit with Plug-In flyout.
3. Select the module you would like to use.
When you access Perfect Effects as a plug-in from Aperture the module
selector is only available for Perfect Layers or Perfect Mask. When you select
one of these modules you can use as many modules as you desire during the
same editing session. At the end of the editing session you must save and close
the image from the Perfect Layers module.
When you select a module other than Perfect Layers or Perfect Mask your
image will be sent to it directly and when you press Apply, the image is saved
and closed automatically and you are returned back to Aperture.

Selecting Multiple Images

If you have multiple images selected, the behavior varies depending on which
modules you select.
Perfect Layers or Perfect Mask: Multiple images will be opened in
separate tabs.
All other plug-ins: Each image will open in a series so you can adjust the
settings on each image.

The file type, bit-depth and color space of the image is determined by the preferences in Aperture for external editors. Perfect Effects will maintain the
file type, either PSD or TIF automatically to support compatibility with plug-ins from other manufactures. Keep in mind only PSD files store re-editable
layers and mask.

Batch Processing
Perfect Batch is the preferred way to batch process. You start with a selection of
images in Aperture or folder on disk, then batch-process them with multiple modules
at the same time to solve complex workflows. For example a portait photographer
can prepare images for a sales session by retouching every face, adding their
stylized look and output small JPGs with their logo watermark, all in the same batch
process. You can access Perfect Batch from the Photo > Edit with Plug-in menu in
Lightroom. You can learn more about using in the Perfect Batch section of this user
guide.
Key batch processing features include:

Start with a selection of images from Lightroom or any folder
you select.
Batch process with a single module for simple jobs or create
workflows where you string multiple modules together.
Save workflows to use over and over.
Pause on the first image to confirm your set-up, then
automatically process the rest to match.
Add a visual watermark, like your logo, to every image.
Edit files in place or create new files with different size, name or
file type.

Perfect Effects
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Using with Other Applications
You can use Perfect Effects as an external editor with many other workflow applications such as Adobe Bridge or Apple iPhoto. First check the application user
guide to see if it supports external editors. It should detail how to configure the host application to use an external editor. Generally this will include selecting
Perfect Effects setting the file type to send to it. It is best to use PSD files if supported. Below are the instructions for configuring iPhoto.

1. Open the Preferences dialog, from the iPhoto menu.
2. Click on the Advanced tab.
3. From the Edit Photos: pop-up select the In Application... option
(note if you have ever selected another external editor, it may be
listed here instead.)
4. From the Choose dialog that appears, navigate the the Perfect
Effects folder, inside the Applications folder and select [Product
Name].
5. In the RAW Photos: option, uncheck the Use RAW when using
external editor option, and check the Save edits as 16-bit TIFF
files option .
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Managing Extras

What are Extras?
The Extras Manager let's you import and manage
your own Extras content. Extras are:
Backgrounds that can be imported and
used in Perfect Layers.
Borders than can be imported and used in
Perfect Layers, Perfect Effects and
Perfect B&W.
Textures that can be imported and used
in Perfect Layers and Perfect Effects.
Presets for Perfect B&W, Perfect Effects,
Perfect Enhance, Perfect Portrait and
Perfect Resize.
Extras can be content that you download from
the onOne website or content that you create on
your own.
The Extras manager lets you create categories
for each Extra type, import files as extras and
delete user-added extras you no longer want.
You can access the Extras Manager from the File
menu in Browse and Perfect Layers or the Preset
menu in modules that use presets.

How to Import Extras
Importing extras is simple. Start by opening the Extras Manager then follow these steps.
1. Select the type of extras you wish to import in the left column (Backgrounds, Borders, etc.) You can only import extras of one type at a time.
2. Click on the Import button in the footer of the left column. A Finder or Explorer Window will appear where you can select the files to import. If you
want to import an entire folder, click into the folder then select the first file, then shift-click on the last file. Click import when you selection is
complete
3. Select a category for your extras to live in. This is where you will be able to find it inside of the Perfect Effects. You can select from an existing
category or create a new one.
When your extras have been imported you will see them in the Extras Manager in the category you selected, in the type of extra they belong to.

What Type of Images Can I Import as Extras?

Backgrounds and Textures may be any image file that Perfect Effects can open including jpg, tif, raw or psd files. Border files
must have a large central area that is transparent. This means that only files that support transparency like png can be imported
as borders.
If you have a .ONPreset file that you have downloaded from the onOne Software website, simply double-click on it to install it. There is no need to
import it through the Extras Manager.
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Browsing Extras
You can browse and open Extras from the Browse
module. In the Sources pane there are sources
for onOne Extras (extras that are provided by
onOne when you installed Perfect Effects) and
User Extras where you can browse and open
extras you have installed.
Inside each source folder are folders for the
Backgrounds, Borders and Textures. You can
open these as layers into Perfect Layers to add
them to an image or layout you are working on.

Using Extras in Perfect Layers
Browsing extras in Perfect Layers is similar to the
Browse module. Click on the Extras tab of the left
column mini-browser. You will see top-level folders
for onOne Extras and User Extras. Inside of
these will be sub-folders for Backgrounds,
Borders and Textures. You can double-click on an
extra to add it to your current image, just use the
"Add as a Layer" option when asked how you
want to open the file.

Then you can use the transform
tool to size and position the extra
on your image.
Use the Layers pane to change the
order, opacity and blending mode.
Use the Masking Brush and
Masking Bug to selectively apply
the extra.
Use the Perfect Eraser to remove
distractions from the extra if
needed.
If you save your file as a layered PSD file, you
can always re-open the file again and have
access to all of the layers and masks for further
editing.
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How to use in a Module
You can access certain extras, like borders and
textures, inside of modules like Perfect Effects
and Perfect B&W. To use them follow these
steps:
1. Open an image into Perfect Effects.
2. In the Filter Options pane, select the
correct filter type, either Borders or
Texturizer.
3. From the Category pop-up, select a
category you have imported. User added
extras categories appear at the bottom
of the category list.
4. From the Texture pop-up select a texture
from the category you selected.

How to Delete Extras
You can remove imported extras using the Extras Manager. Follow these steps:
1.
2.
3.
4.

Open the Extras Manager.
Click on the extras type that contains the content you wish to remove. This will display categories within that extras type.
To delete an entire category, select in the left column and click on Delete button in the footer of the left column.
To delete individual extras, select them in the right column and click on the Delete button in the footer of the right column.
Deleting extras is permanent and can not be undone!

See also
Using the Help System
Contacting onOne Software
Additional Help
System Requirements
Installation
Licensing and Registration
Opening and Saving Files
Using Modules
Using as Standalone
Using with Adobe Photoshop
Using with Adobe Lightroom
Using with Apple Aperture
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Using with Other Applications
Preferences
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Preferences
The preferences dialog contains general application settings. The preferences are accessed from the Perfect Effects menu on Mac or the Edit menu on
Windows.
The preferences contain the following controls:

General Settings
1. Working Color Space: When a new file is created or file is
opened and has no color profile associated with it, this is the
assumed color profile for the image. Images that come from
other hosts or have tagged or embedded profiles will use the
associated profile instead.
2. Scrolling Controls: Lets you select how the mouse scroll
wheel or scrolling gesture works. The options are:
1. None: Default
2. Preview Zoom: Adjusts the zoom of the preview
window. Scrolling up increases the zoom, scrolling
down decreases the zoom. It is important that the
zooming is comfortable, not too fast or slow or jerky.
3. Preview Pan: Pans the image, like using the pan
tool or navigator. It is important that the panning is
comfortable, not too fast or slow or jerky.
4. Brush Size: Adjusts the size of the current tool if
relevant, such as a brush tool.
3. Preview Background Color: You may select the color of
the background behind the preview image. The default color
is black. There should be options for black, white, light gray,
dark gray and custom... The custom option a color picker
where you can select your own background color
4. Start In: Determines which module will open at

launch. Browse is the default.
5. Remember Last Browsed Folder: Enabled by default this
will will open the last browsed folder when you launch the
program.
6. Check of Updates on Launch: Enabled by default, the
product will communicate with onOne server at launch and if
an update is available it will prompt you to download, or skip.
7. Warn when leaving files in Layers: Enabled by default,
if you have unsaved files open in Layers and want to close
the program a warning dialog will appear with the options to
Save & Close, Cancel, or OK which will close without saving.

Lightroom Plug-In Settings
1. File Type: Specifies four options. PSD (Supports Layers,
Defaults Setting. Same as Source (PSD for Raw). TIFF (No
Layers). JPEG (No Layers).
2. Color Space: Specifies the color space to use when
processing copies from Lightroom. This is similar to the
working color space pop-up in the general preferences tab,
however there are only the three options supported by
Lightroom: sRGB, Adobe RGB 1998 and ProPhotoRGB.
3. Bit Depth: Sets the bit depth for the copies created by
Lightroom, the options are 8 and 16 bit.
4. Resolution: Sets the resolution of copies created by
Lightroom.
5. Stack with Original: Enabled by default, copies created by
Lightroom are stacked with their original or source image.
6. Use Original for Single PSDs: Enabled by default. If your
selection is a single PSD file, the original PSD is opened rather
than creating a copy.
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Performance Settings
1. Memory Usage: Specifies the amount of system memory
(RAM) that is used by the application. The default is 80%.
2. VRAM Usage: Specifies the amount of video memory
(VRAM) that is used by the application. The default 80%.
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Browse Module
The Browse Module is the perfect place to find the images you want to edit with Perfect Effects. It gives you
easy access to all your images, no matter where they live on your computer, network or cloud based storage
service. You can browse and search any file type that is supported. You can also view your images as a
thumbnail grid or larger detail view along with important metadata.
Some of the features:

Find your photos fast, anywhere they live
Local drives
Network drives
Online storages services
Create a selection of images for Batch processing
Fast browsing without the need of a catalog
Copy, move, delete and rename files
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Getting Started
This getting started section will give you the basics of using the Browse Module. You might also try watching the getting started video tutorial. For
detailed information on steps and controls mentioned in the getting started section, see the "Using the Browse Module" section instead.

Pages in this Section
Browse Workspace
Finding and Opening Files
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Browse Workspace
The Browse Module allows easy access to your images on your computer, network or cloud based storage device while viewing a thumbnail grid or scrolling
through a larger detail view.

The Main Window:

The main window sections of Browse Module:
A.
B.
C.
D.

Info Pane: This section will give you detailed information about your image when available.
Sources Pane: This contains a list of common photo locations, including disks, favorites and cloud storage services.
Folders Pane: This displays the hierarchical tree view of the current selected Source.
Recent Pane: This keeps track of recently opened files and folders.

E. Module Selector: This lists the available modules.
F. This will display the number of files and folders you are viewing, you can use the arrow keys to move from item to item.
G. This is your main preview window where you can view your images as thumbnails or a larger detail.
H. Use this button to switch from thumbnail view to detail view.
I. This slider will adjust the thumbnail size in your main preview window.
J. This pop up will adjust your sort from filename to date modified in your main preview window.
K. This search box allows you to search by name the contents of the current folder.
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Finding and Opening Files
1. Start by selecting a source for your images in the left Sources pane. Any disks inside or attached to your computer will appear

2.

3.
4.
5.

as disks. Supported Cloud Storage services appear at the top of the list. Any favorites, like your Pictures folder, will appear at
the bottom of the list.
Once you select your Source, navigate to the folder in the Folders pane to find your images. You can also do this within the
thumbnail matrix. Once you have found a file you wish to work on simply click on the file to select it. The thumbnail will appear
to be highlighted.
Click on the module you want to use in the Module Selector located in the top right (A) or you can also right-click and choose
a module in the pop up menu (B).
The Edit What dialog will appear with file options. Select your options and click "Open" to begin working on your image.
When you complete your work in a module, return to Browse to automatically save and close the image.
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Using the Browse Module
This section covers the complete use of the Browse Module. It includes how to navigate your folders, customize
sources as well as information on preferences and menu options.

Pages in this Section
Using the Info Pane
Navigating Sources
Navigating Folders
Navigating Recent Pane
Working in Thumbnail View
Working in Detail View
Managing Files and Folders
Opening an Image
Menus
Keyboard Shortcuts
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Using the Info Pane
The Info Pane displays the metadata for the currently selected file. This information may include:

Camera Make and Model
Focal Length
Capture Date and Time
File Type
GPS Data
ISO
Shutter Speed
Aperture
Exposure Compensation value

*If any of the metadata fields are unavailable they will be left blank.
Additional generic file information is also displayed in the Info Pane Including:
Filename

Colorspace (color profile)
Pixel Dimensions and Resolution
Image size and Bit depth

GPS Metadata
If your image has GPS metadata embedded in it, the GPS button will appear. Clicking on this button will open the default web browser to Google Maps and
navigate to the location where the image was taken.
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Navigating Sources

The Sources Pane contains a list of cloud storage services, attached disks, and common or favorite
locations.

Cloud Storage Services
Browse supports several common cloud storage services including Dropbox, Google Drive, Microsoft Sky
Drive and Apply iCloud Photo Stream. All of these services keep local copies of your images on your
computer. Browse finds and monitors these locations automatically. If you edit an image stored in one of
these locations they are automatically updated to the cloud.
Browse automatically finds the default installation locations for these services. If you do not have one of
these services installed, or you have it installed to a non-standard location you will be asked to install or
locate the folder when you click on the source.

iCloud Photo Stream is a read-only source. You can open an copy of an image from it and save it
to a new location only.

Attached Disks
Browse automatically recognizes any disk (volume) inside or attached to your computer. This includes:
Hard drives in your computer
Hard drives attached to your computer with USB, Firewire, Thunderbolt, etc.
Optical drives
USB thumb drives
Digital camera memory cards
Digital cameras, music players and smartphones that support USB Mass Storage
Network drives
Disks appear in the middle of the Sources pane with a hard drive icon next to them. Keep in mind that
some disks, like optical drives, are often read-only. You will be able to open a copy of an image, but will be
prompted to save the image to a new location.

Favorites
Browse also supports creating Favorites. A Favorite is a short-cut to any file path where you store your
images. Several Favorites are installed by default such as your Desktop, Pictures and the onOne Sample
images folders.
You can create your own Favorites by pressing the plus icon at the top of the Sources pane. An open
dialog will appear where you can navigate to the folder you wish to add as a Favorite. You can also
remove a favorite by selecting it in the Sources pane, then pressing the minus button.
You can also add a favorite by simply dragging it into the Sources pane.
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Navigating Folders
The Folders pane displays the hierarchical tree view of the current selected Source. You
can close and open the subfolders by clicking on the triangle. You can navigate to your
folder of choice within the pane or you can also use your preview window. Keep in mind
that the Folder view only shows the folders, or directories inside the current source. This
helps to reduce clutter and make it faster to find the image you are looking for. If you need
to see folders outside of the current source, select the disk the images are located on
instead of the Favorite.
You can add a new folder, as a child of the current folder, by pressing the plus icon.
You can delete the current folder by pressing the minus icon.
You can rename a folder by right-clicking and selecting Rename.
You can move a folder by dragging it into another folder.
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Navigating Recent Pane

The Recent Pane keeps track of recently opened files or manually browsed folders. Files are listed in
order of last opened. If you have not opened any files this pane will be empty. You can quickly access
your most recent files in this pane by clicking on the one you want and it will appear in your main preview
window. Keep in mind the Recent pane only shows files you have opened directly from Perfect Effects,
not files you have sent to Perfect Effects from Lightroom, Aperture or Photoshop.
You can clear the recent file list by pressing the trash can icon.
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Working in Thumbnail View
The Thumbnail area is the largest part of the main window and it is responsible for displaying thumbnails of folders and images you have selected using the
Source and Folder Panes.

A. Adjust the size of the thumbnails using the slider located at the bottom or use "-/+" keys on your keyboard.
B. Change the viewing mode between thumbnail and detail view.
C. When Previewing images at full screen you can quickly go to the next image by using the navigational arrows.
D. Use the breadcrumbs to quickly return to the root or click "back" to return one folder.
E. Sort the thumbnails by filename or date using the pull down menu. The sort will always be descending, A-Z or oldest to newest.
F. Search for folders or files in the current folder.

Selecting Multiple Images
Select the first image and hold down on the 'shift' key and click on the last image of the group. If the images you wish to select are not in sequential order you
can select each image individually by selecting the first image, now hold down 'Command' (Mac) or 'Control' (Windows) and select each image(s) while continuing
to hold down on the Command/Control key.

See also
Using the Info Pane
Navigating Sources
Navigating Folders
Navigating Recent Pane
Working in Detail View
Managing Files and Folders
Opening an Image
Menus
Keyboard Shortcuts
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Working in Detail View
In Detail View you can see a full-screen version of images. By default when you go to Detail View, your images will be displayed in fit mode, so you can see the
entire image. However you can click on the image to zoom in to 100% or actual pixels. This is useful for judging small details and sharpness. Single-clicking on a
image that is magnified will return back to fit mode. You can click and drag a magnified image to look around. Your zoom mode is maintained as you move from
image to image so you can compare the same spot in several frames.
There is also a Navigator pane where you can reposition the preview and change the magnification amount.

See also
Using the Info Pane
Navigating Sources
Navigating Folders
Navigating Recent Pane
Working in Thumbnail View
Managing Files and Folders
Opening an Image
Menus
Keyboard Shortcuts
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Navigating the Preview
This provides several ways to navigate and view your image in the Preview window.

The Preview Window above is the main section where you preview and work on images.
Hand Tool
The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area.
To pan (scroll) in the Preview window:
Select the Hand Tool and drag the image until you locate the area you wish to view.
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window.
With the Zoom tool selected:
Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator
At the top of the control panel on the right of the main window is the Navigator | Info panes. It contains four useful tools for inspecting and viewing details
of your image.

The Navigator Pane
This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region.
At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate.
FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%
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Managing Files and Folders
You can use the Browse module to organize, delete and rename files and folders. This makes it a useful workflow tool for any photographer.

Deleting a file or folder
To delete a file or folder in the preview area, simply press the delete key or
select delete from the right-click contextual menu.
Then confirm that you wish to move the file to the trash. If you make a
mistake you can use the undo command. If you have multiple files and or
folders selected it will move them all to the trash. Some files or folders, like
those on a network volume must be deleted immediately and cannot be
undone.

Renaming a file or folder

You can rename a file or folder by selecting it, then choose Rename from the right-click
contextual menu.

Creating folder

You can create a new folder from the the right-click contextual menu in the preview area or
by pressing the plus "+" icon in the Folders pane. This will create a new folder inside the
selected folder.

Copying and Moving files and folders
You can copy and move files and folders in the ways you are accustomed to on your
computer. You can select files and folders and use the copy command to copy them to the
clipboard and then the paste command to paste them to new location, inside or outside of
Browse. You can use this to copy a file or folder from one place to another or to attach an
image to an email for example.
You can also use the familiar drag and drop functions to copy or move files and folders.
Dragging and dropping a file or folder will move it if it is on the same drive or copy it to
another drive. You can drag and drop into and out of the Browse module.
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Opening an Image
Select the file and select a module from the module selector in the upper right menu bar or right click on the file and choose a module from the pop up menu. You
will be presented with the What to Edit dialog below.

What to Edit
After you have selected a file and chosen a
module a File Options dialogue will appear.
You can choose between: Edit a Copy, Edit
Original or Add as a Layer.
Edit a Copy- This is the default option. A
copy of the image is created and will be saved
to the same path as the original file. After
you Save/Apply the file name will be (Original
Filename) copy.ext — with the extension you
have selected.
Edit Original- This option will open the
original file and overwrite the current file
when saved. This option will be unavailable
for camera raw files or read-only files.
Add as a Layer- This opens the original file
and it is added as a layer in Perfect Layers.
This option is only available for launching in
Perfect Layers.

Copy Options
File Format- Choose one of the following
file formats you wish to work with.
Photoshop (.psd) files will support layers, this
means when the file is saved all the individual
layers will be available again when re-opened.
For Tiff and JPEG no layers will be retained
and the Layers will be merged into a single
composite when saved.
Color Space- This will list the RGB color
profiles installed on your system.
Bit Depth- This sets the bit-depth of the
copied image. This option is unavailable for
JPEG format, which is limited to 8-bit.
Resolution- This sets the resolution or ppi
for the image, it is 300 by default.

See also
Using the Info Pane
Navigating Sources
Navigating Folders
Navigating Recent Pane
Working in Thumbnail View
Working in Detail View
Managing Files and Folders
Menus
Keyboard Shortcuts
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Menus
Perfect Effects (Mac OS X Only)
About Perfect Effects: Opens the about box, displays your version
number and activation code. (Help menu on Windows)
Preferences: Opens the preferences dialog. (Edit menu on Windows)
Quit Perfect Effects: Quits Perfect Effects.

File Menu
Browse Folder: Opens the browse dialog where you can select which
folder you would like to browse
Add Favorite: Opens the add favorite dialog that you can add a favorite
folder permanently to the Sources pane
Manage Extras: Opens the Extras Manager where you can import and
manage extras like Borders, Backgrounds, Textures and Presets.
Edit in...: Will launch the module with the file you have currently selected
Batch: Opens the Batch mode window

Edit Menu
Undo: Undoes the last file operation. This is only available the last thing you
did.
Redo: Redoes the undo operation. This is only available if the last thing you
did was an undo.
Select All: Selects all the images in the current folder
Select None: Deselects all the images in the current folder
Deselect: Deselects the current item
Copy: Copies the currently selected items
Paste: Pastes (copies) the items in the clipboard to the current location
Rename: Renames the selected file or folder
Delete: Moves the selected files and or folders to the trash
Add Subfolder: Adds a new empty subfolder inside the current folder

View Menu
Bigger Thumbnails: Increases the size of the thumbnails
Smaller Thumbnails: Decreases the size of thumbnails
Sort: Sort by filename or date
View Mode: Select from thumbnail or Detail view.
Preview Background Color: Change the preview background color the
thumbnails
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Window Menu
Info: Opens and closes the Info pane.
Sources: Opens and closes the Sources pane.
Folders: Opens and closes the Folders pane.
Recent: Opens and closes the Recent pane.
Show Browse Panel: Hides or reveals the entire Browse Panel (left column
of control panes).
Hide Panels: Hides or reveals both the left and the right Panels.
Full Screen Mode: Enters or exits full-screen mode

Help Menu
Search: Searches the menus (Mac OSX only).
Browse Online Help: Opens this html Help in your default web browser.
Video Tutorials: Opens the online Video Tutorial in your default web
browser.
Getting Started: Opens the online Getting Started overlay.
Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.
Perfect Inspiration: Takes you to the Perfect Inspiration web site.
Check for Updates: Checks with the onOne update server to see if you
are running the current version. If there is a newer version you will be
notified and be walked through the update process.
Deactivate: Opens the activation dialog. These are used to deactivate
your software for moving it to another computer or for a return.
Registration: Opens the default web browser and navigates to the
registration page of the onOne website.
Provide Feedback: Opens the default web browser and navigates to the
feedback page of the onOne website.
Help Improve onOne Products: Opens the Improve onOne Products
dialog.
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Keyboard Shortcuts
Browse Folder

Mac OSX

Windows

cmd b

ctl b
ctl q

Exit

cmd q

Select All

cmd a

ctl a

Select None

cmd d

ctl d

Deselect

/

/

Bigger Thumbnails

cmd +

ctl +

Smaller Thumbnails

cmd -

ctl -

Return to Thumbnail View

esc or g

esc or g

Switch to Detail View

e

e

Delete Item

delete

delete

Copy Selected Items

cmd c

ctl c

Paste Items from Clipboard cmd v

ctl v

Zoom in

ctl +

cmd +

Zoom out

cmd -

ctl -

Fit to screen

cmd 0

ctl 0

Actual pixels

cmd opt 0

ctl alt 0

Info

cmd 1

ctl 1

Sources

cmd 2

ctl 2

Folders

cmd 3

ctl 3

Recent

cmd 4

ctl 4

Hide Panels

tab

tab

Full Screen Mode

cmd ctl f

F11

Keyboard Shortcuts

cmd shift k ctl shift k

Perfect Effects

44 Perfect Effects

Perfect Effects
Perfect Effects gives photographers a fast and powerful way to create images with
impact.
It includes an updated library of professional quality photographic filters that can be previewed live
on your image before being applied. Live previews are shown in full screen so you can see your
image at its best. You'll enjoy the ability to stack multiple filters together to create your own unique
look.
Perfect Effects takes the idea of stacking filters further with updated blending options that provide
better control over how effects are combined. These advanced tools include blending modes options
and the ability to limit filters to specific color or tonal ranges of an image.
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Getting Started
This getting started section will give you the basics of using Perfect Effects. If you have never used Perfect Effects before this is a good place to start. You can
also watch the getting started video tutorial. For detailed information on steps and controls mentioned in the getting started section see the Using Perfect
Effects section instead.
When to use Perfect Effects
The broad range of effects in Perfect Effects makes it useful at many steps in the digital workflow. For example, the filters in the Brightness, Contrast and Color
Correction categories may be used early in the workflow for correcting the color and tone of an image. While filters in many categories are designed for a more
artistic effect, it may be used in the middle of the process as well. Finally, Perfect Effects has several filters designed for sharpening in the Sharpening category
that should be applied as the last step before printing.
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User Interface
Perfect Effects Main Window:

A. Effects Browser: This library of filters is located on the left side of the window for easy browsing.
B. Tool Well: This is where the tools are located.
C. Preview Window: This is the main section where you preview and work on images.
D. Tools Option Bar: This is where information and options about each tool is set.
E. Module Selector: This is where you choose which software module to open.
F. Navigator, Loupe and Histogram Pane: This pane will access the Navigational, Loupe and Histogram features.
G. Filter Stack: This is where you view and stack filters.
H. Filter Options: This is where you access the filter options pane.
I. Cancel/Apply Buttons: This is where you cancel or apply an action.

The Perfect Effects Tool Well
There are four different tools in the Perfect Effects tool well. More details about each tool will be covered in the next chapters.

Masking Brush

This masks out areas using brush strokes to expose underlying layers.

Masking Bug

This tool lets you mask out the layer to expose the original

Hand Tool

This tool drags your image within the preview window when it's larger than the viewable area.

Zoom Tool

This tool changes the magnification in the preview window.

Perfect Effects

underlying image.
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Navigating the Preview
Perfect Effects
This provides several ways to navigate and view your image in the Preview window.

The Preview Window above is the main section where you preview and work on images.
Hand Tool
The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area.
To pan (scroll) in the Preview window:
Select the Hand Tool and drag the image until you locate the area you wish to view.
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window.
With the Zoom tool selected:
Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator, Loupe, Histogram and Info
At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane
This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region.
At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate.
FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

The Loupe Pane
This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.
At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.
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The Histogram Pane
This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.
The left side of the histogram represents the shadows, while the right represents the
highlights. At the top of each end is a triangle. If the triangle is lit, there is clipping on that side
of the histogram. If you click on the arrows, you will activate the clipping overlay on your
image. The areas of your image with a blue overlay are pure black, while the areas with the red
overlay are pure white. You can turn the clipping view off again by clicking on one of the
triangles. You can also temporarily enable clipping view by holding down the J key at any time.
The clipping view is useful when you are making adjusts to the brightness and contrast of your
image.
The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.
Clipping View

The Info Pane
The info pane will display important metadata about your file including:
Camera type
File type
Focal length and lens information
Date and time captured
Exposure information
ISO
Shutter Speed
Aperture
Exposure Value
Filename
Color Space
Dimensions
File Size and Bit Depth
If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS
enabled on your camera or mobile device. Otherwise you will not see the GPS button.
The Info panel is not visible when you access Perfect Effects as a Photoshop plug-in.
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Preview Window Modes
The preview window has several modes including; single image, side-by-side (horizontal or vertical) and split-screen (horizontal or vertical) versions of an
image. This allows you to compare layers side-by-side or to view a layer mask and the layer side-by-side. At the bottom left of the Preview Window is a
button that toggles and shows the current Preview Mode. You can also change the mode from the View menu.

Single Mode Screen.

Left-Right Screen.

Top-Bottom Screen.

Top-Bottom Split Screen.

Left-Right Split Screen.

Tip: You can use the keyboard shortcuts below to quickly switch view modes. Items in parenthesis are for Windows.
Command (Control) L:
Command-Option (Control-Alt) L:
Command (Control) T:
Command-Option (Control-Alt) T:
Command (Control) Y:
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Change the preview mode to Left/Right.
Change the preview mode to Left/Right Split screen.
Change the preview mode to Top/Bottom.
Change the preview mode to Top/Bottom Split screen.
Change the view mode to single image.
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Using Perfect Effects
Perfect Effects is designed to work in steps by adding and adjusting multiple effects on top of each other. If you are a photographer, think of this like adding
filters over your cameras lens. First, you would add a polarizer to increase the contrast. Next you would add a graduated neutral density filter to darken the sky
and perhaps add a vignette lens hood to darken the edges. This same concept is what drives Perfect Effects, except you have many more filters and more
flexibility and control.
Perfect Effects provides several ways to work depending on your skill level. It works for beginners through advanced users. Below are example workflows for
different levels.

Beginner
A new user can simply click on an filter and apply it. This is the easiest way to get started.
1. Start by opening an image into Perfect Effects.
2. On the left side you will see the Browser with a list of categories. Click on a category to open up a series of filters. You will now see your image with
different filter applied.
3. Simply click on the filter you like and press the Apply button.

Intermediate
An intermediate user may try stacking filters and adjusting their strength.
1.
2.
3.
4.
5.

Start by opening an image into Perfect Effects.
Add a filter from the Browser, adjust its strength with the sliders in the Filter Options pane.
Add another filter layer by pressing the Add button in the Filter Stack pane, then select a new filter from the library.
Continue to add filters and adjust their settings.
When you have created a filter stack you like, press the Apply button.

Advanced
An advanced user may stack multiple filters, adjust the strength, blending options, filter options and use the masking tools to selectively apply filters.
1.
2.
3.
4.
5.
6.
7.

Start by opening an image into Perfect Effects.
Add a filter from the Browser.
Adjust the filter options in the Filter Options pane. This pane contains controls relevant to the selected filter.
Use the blending options to control the blending mode. You can also control which color or tonal ranges are affected.
Continue adding effect filters, adjusting the filter options and blending options to achieve the desired look.
Use the masking tools to selectively apply each filter layer by painting them in or out or applying a filter as a gradient or vignette.
When you have created a filter stack you like, press the Apply button. You can also save a stack as a preset so it can be used again later.
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Browsing Filters
Built into Perfect Effects is a browser, located in the left panel. You can use it to browse the factory supplied filters, presets you have created or downloaded
from the onOne website or for marking and finding your favorites. Below is a description of the controls in the browser.

A. Browser Tabs: This switches between filters, presets and favorites.
B. Search Field: Use the search field to locate files in the current sub-folder. Simply start to type and your results
will appear in a new sub-folder called search results while you type.
C. Filter Categories: This will list the different filter categories for you to choose from.
D. Image File: A thumbnail of the image is displayed and will have the filter applied to it.
E. Resize Handle: On the right edge is a resize handle that you can drag to change the size of the browser or
close it.
F. Browser Modes: These icons control the browser views. One column, two column, three column or list view.
G. Quick View Browser Button: Press this button to open the current folder in the Quick View Browser.

Browser Tabs
The Browser is divided into three tabs; Filters, Presets and Favorites.
Filters: The Filters tab contains the factory Filters provided by onOne Software.

Presets: When save your own presets, or install presets from the onOne website, they will be located here.
Favorites: When you click on the favorite flag on a filter or preset, in any tab, it is added to the Favorites tab automatically. This makes it fast to find
the filters and presets you use most frequently.

Navigating the Browser
To open a category, click on it. To close it, click on it again.
Only one top-level folder can be open at a time.
The selected item, either a category, filter or preset, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
You can open or close categories using the command (control on Windows) up and down arrows.

You cannot move or delete presets from the browser.

Selecting a Filter or Preset to Use
To activate a filter or preset on your image, simply click on it.
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Searching
To search for filters or presets in the current browser tab, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up
To view a larger preview on a filter or preset, enable the Show Browser Pop-up in the View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up window.

Resizing and Closing the Browser
The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the cmd (control on Windows) left and right arrow keys.

Browser Modes

The browser offers four
viewing modes. Three that
display thumbnails in
columns and one list view.
The browser modes are
selected using the browser
mode icons at the bottom
of the browser.

single column view

two column view

list view

Quick View Browser
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The Quick View Browser adds an
elegant full-screen view of your
images, filters and presets.
Whether you are looking for the
right image or the right look, the
Quick View Browser will make fast
work of the problem. Just press
the Quick View Browser button
(or the option (alt) right arrow
keyboard shortcut) and you will
see the full array of options to
choose from. You can visually
navigate categories, then dive
into them to find just the right
look.
Browse folders and
images quickly to find
the right one to work on.
View all your filters or
preset categories at one
time, then dive into them
to find the perfect look
with an effortless, tablet
feel.
Variable thumbnail sizes
gives you a few large
previews or many small
ones depending on your
screen size and content.
Back button and
breadcrumbs make it
easy to navigate a
complex folder
structure.
Use your keyboard
arrow keys to navigate
Press the return key to
select an item or open a
folder.
Use the command or
control left arrow to go
up a folder level.
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Using the Filter Stack
The Filter Stack is a list of all Filters and presets added to an image.
When you add a Filter to your image, it will appear on the current Filter Layer in the Filters
Stack pane. The Stack works similar to the Layers or History palettes in Photoshop. At the
bottom of the Filters Stack is your original image. Each Filter you select in the Library will
replace the Filter on the currently selected Filter Layer.
You can create as many Filter Layers as needed.

You move forward and backward in time by selecting different Filter Layers in the Stack.
For example, if you had a Filter Stack with the original and three Filter Layers applied, you could go back to the first Filter by selecting it in the Filters
Stack. The second and third Filter Layers will appear disabled and your preview will show only the results of the original with the first Filter Layer applied.
You can then click on the third Filter Layer, the most recently applied, and the second and third Filters will appear active again and the preview will show
the results of all three Filters. The results of each Filter Layer in Perfect Effects are cumulative, so the results of the first Filter are passed to the second
Filter and so forth.
It is best to work with Perfect Effects in a step-by-step process, knowing that the results from each step are the starting point for the next Filter. This
means that when selecting the Filters to apply, think about the workflow order you use.
It is best to make color and tonal adjustments first, followed by special Filters and finish with final touches such as vignettes and sharpening. Thinking of
the proper steps to add Filters in Perfect Effects will give you better and faster results.
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Changing the Current Filter
When you start in Perfect Effects, there will be an empty Filter Layer on top of your original.
Your original is at the bottom of the Filter Stack. To add an Filter to the empty Filter Layer,
select it first, then click on an Filter thumbnail in the Filters Browser. You can change the Filter
in a Filter Layer by clicking a different Filter thumbnail in the Filter Library.

Adding Filters
To add another Filter Layer so you can stack multiple Filters, click the Add button at the bottom
of the Filters Stack. This creates a new empty Filter Layer. Then select another Filter from the
Filter Browser.
You can also double-click on an Filter in the Filter Browser to place it in the current Filter Layer
and add a new empty Filter Layer above it.

Hiding Filters
A Filter may be temporarily hidden or revealed by pressing the Eye icon next to the Filter in the
Stack. When you hide a Filter, you are not removing it from the Stack. You can reveal it again
anytime. Keep in mind that hiding a Filter in the middle of the Stack may take a moment to rerender and update your preview.

Changing Filter Order
Filters may be reordered in the Stack by clicking and dragging them into the desired position.
Reordering Filters can have a huge difference on the results of the image. Reordering Filters
will cause the Stack to re-render which may take a few moments.

Deleting an Filter
You remove a Filter by selecting it and pressing the Delete button at the bottom of the Filters
Stack or by pressing the delete key on your keyboard.

Tip: You can clear all the Filters from the Frame Stack at once by option (alt on
Windows) clicking on the delete button.

Adjusting the Opacity
The Layer Opacity slider controls how the selected Filter blends with the previous Filter or the original image. You adjust the opacity for any Filter by
selecting it and then adjusting the layer opacity slider. Adjusting the opacity slider effectively adjusts the strength of a Filter. For example, if you add a
black and white conversion Filter, sliding the layer opacity down will reveal some of the color from the previous state. Usually, the opacity slider will be set
to 100% when you add a Filter, however with some Filters like vignettes and soft focus Filters, it may be automatically set at 50%.
Adjusting the layer opacity slider to greater than 50% will make the Filter stronger, while adjusting it to less than 50% will make the Filter weaker.

Blending Options
Clicking on the Blending Options arrow will drop down the Blending Options. This window offers
advanced blending options between Filters.

The blending options controls are:
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Blending: A pop-up list of blending modes. The list includes normal, lighten, darken, screen, multiply, softlight, hardlight, overlay and color.
Apply Filter To: A pop-up list of color or tonal ranges will appear, only one may be selected. The options are; all, highlights, midtones, shadows,
reds, greens, blues, magentas, cyans, yellows, flesh colors, vivid colors and neutrals. This applied Filter creates a selection based on the lightness, hue, or
saturation range specified. There is a Fuzziness slider associated with this control that adjusts the hardness or precision of the selection. The range is zero
to 100.
Custom: Select the Dropper tool and click on the image to sample a custom color range.
Protect: The protect sliders are used to remove an Filter from a specific color or tonal range. The sliders are; highlights, shadows and skin. The selection
created should be feathered and appear natural. The default for these sliders is zero; the range is zero to 64. The range for Flesh Colors is zero to 100.
Reset: This resets all settings to the original default settings.
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Using Filters
Perfect Effects has its own image-processing engine. This allows you to control the settings for
many filters down to the smallest detail.
There are 23 Filters that do all the work in Perfect Effects. Stacking and blending these filters will
create different effects. These filters are accessed in the Filter Options pane or the Browser

The Filters are:
Adjustable Gradient
Adjustment Brush
Antique
Black and White
Bleach Bypass

Blur
Borders
Color Enhancer
Cross Process
Dynamic Contrast
Glow
Grunge
HDR Look
Lens Blur
Photo Filter
Portrait Enhancer
Sharpening
Split Tone
Sunshine
Texturizer
Tone Enhancer
Vignette
Vintage

Adjustable Gradient
Adjustable Gradient makes it fast to add common adjustments to a portion of the image. Adding the
Adjustable Gradient will automatically activate the Masking Bug. This is used when you want to
apply a custom filter to a particular area of an image.
Preset Icons: Shortcuts to the most popular presets.
Presets: Pop-up that lists all built-in presets for the filter.
Brightness: Adjusts the overall brightness of the image.
Contrast: Adjusts the overall contrast of the image.
Compression: Compresses the tonal scale to reveal highlights and detail.
Detail: Enhances the details by increasing the micro contrast.
Warmth: Makes the image warmer or cooler.
Vibrance: Controls the vibrance or saturated the colors appear.
Glow: Adjusts the image glow.
Type: Sets the style or blending for the glow.
Reset will return the settings to the default.
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Adjustment Brush
The Adjustment Brush filter lets you paint-in common adjustments just where you need them.

Preset Icons: Shortcuts to the most popular presets.
Presets: Pop-up that lists all built-in presets for the filter.
Brightness: Adjusts the overall brightness of the image.
Contrast: Adjusts the overall contrast of the image.
Compression: Compresses the tonal scale to reveal highlights and detail.
Detail: Enhances the details by increasing the micro contrast.
Warmth: Makes the image warmer or cooler.
Vibrance: Controls the vibrance or saturated the colors appear.
Glow: Adjusts the image glow.
Type: Sets the style or blending for the glow.
Reset will return the settings to the default.
Reset will return the settings to the default.

When you add an Adjustment Brush, nothing appears on your image until you paint it in
where you want.

Antique
To give your image an aged look, older than the vintage filter, monochromatic or hand colored.

Preset Icons: Shortcuts to the most popular presets.
Presets: Pop-up that lists all built-in presets for the filter.
Brightness: Adjusts the overall brightness of the image.
Haze: Adds haze or white fill to the image.
Saturation: Adjusts the color saturation.
Color: Drop down menu displays a list of color options similar to the
duotone filter.
Film Grain: Amount controls the strength and size dictates the how large the
grain appears.
Reset will return the settings to the default.
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Black and White
The black and white effect is used to turn a color image into a monochromatic image.
Preset: A preset menu drop down full of popular looks.
Filter: Simulates placing a colored filter over your lens when photographing with black and
white film. It works like a channel mixer, choosing the percentage of each channel to use.
Brightness: Adjusts the overall brightness of the image.
Contrast: Adjusts the overall contrast of the image.
Auto: Selects the Black and White points automatically.
Highlights: This slider darkens the highlights recovering detail.
Shadows: This slider lightens the shadows revealing detail.
Whites: This slider adds more contrast to the whites.
Blacks: Adds more contrast to the blacks.
Detail: Enhances the fine details.
Toner: A drop-down list of darkroom toners which add a subtle color tint to the image.
Highlights: Click on the color square to select the highlight toner color. The Amount slider
controls the strength of the toner color on the highlights.
Shadows: Click on the color square to select the shadow toner color. The Amount slider
controls the strength of the toner color on the shadows.
Swap Colors: Pressing this button swaps the highlight and shadow colors.
Preserve Whites and Blacks: When on, this checkbox keeps the pure whites and blacks
neutral instead of taking on the color of the toner.
Film Grain: A drop-down list of Film Grains from popular black and white films. Amount
slider is for controlling the strength. Size slider adjust the scale of the grain.
Reset will return the settings to the default.
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Bleach Bypass
An old color processing technique when the bleaching step was skipped. It reduces the saturation
and increases the contrast.

Preset Icons: Shortcuts to the most popular presets.
Presets: Pop-up that lists all built-in presets for the filter.
Amount: Controls the strength or amount of the bleach bypass appearance.
Brightness: Adjusts the overall brightness of the image.
Contrast: Increases or decreases the global contrast.
Detail: Enhances the details by increasing the micro contrast.
Saturation: Adjusts the underlying saturation.
Tint: Choose a new color by clicking in the color icon.
Amount: Adjust the strength of the tint.
Reset will return the settings to the default.

Blur
The blur filter contains four options for blurring the image. These options are Normal, Radial, Motion
and Surface. Each Type of blur has it own individual sliders. Use the Preset drop down menu or
click on the Type Icon to select the blur.

Normal: A gaussian blur applied to the entire image. Amount slider
controls the strength of the blur. Halo slider controls the fuzziness of the
radius.

Radial: A zoom from center style. Amount controls the strength of the blur.
Quality controls how noisy or the graininess of the blur. Smoothing softens
the lines created by the motion. The Radial option also includes a center
spot selector. Activate the spot selector by clicking on the icon and then
click on the part of the image you want to make the center of the radial blur.

Motion: A motion look to make the object or camera appear to be moving.
Amount controls the strength of the blur. Distance controls the blur relative
to area between the subject and camera. Angle sets the angle of the blur.
Smoothing softens the lines created by the motion. *The Shake preset is a
motion type.

Surface: Simply maintains the edges but adds blur to the details. Amount
slider controls the strength of the blur. Halo slider controls the fuzziness of
the radius. Threshold sets how similar colors are grouped.
Reset will return the settings to the default.
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Borders
Adds authentic looking borders.
Preset: Drop down menu of popular borders.
Category: Sets the category.
Border: Selects which border to add.
Mode: Sets the blending mode for the border.
Opacity: Sets the strength or opacity.
Hue: Sets the hue of the border.
Saturation: Sets the saturation of the border.
Brightness: Sets the brightness of the border.
Thickness: Sets the thickness of the border.
Fit Image: Adjusts the size of the image under the border.
Button icons (right to left): Rotate clockwise 90 degrees, rotate counterclockwise 90
degrees, flip vertically, flip horizontally.
Reset will return the settings to the default.
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Color Enhancer
The color enhancer can be used to control the saturation or vibrancy of colors in the image. This
can be done on a global basis (All) or per a range of colors.

Presets: Pop-up that lists all built-in presets for the filter.
Auto: Detects and removes a color cast.
Temperature: Adjusts the warmth of the image.
Tint: Shifts the hue between green and magenta.
Vibrance: Adjusts the vibrance of muted colors.

Gray dropper: Manually select a gray area to set the temperature and tint
sliders automatically.
Limit Vibrance on Skin box: When checked will protect flesh tones.
Color Range: Selects which color range to adjust.

Hue: Changes the hue for the selected color range.
Saturation: Adjusts the saturation of the selected color range.
Brightness: Adjusts the brightness of the selected color range.
Purity - Highlights: Reduces the saturation in the highlights.
Purity - Shadows: Reduces the saturation in the shadows.
Reset will return the settings to the default.

Cross Process
This filter simulates processing film deliberately with the incorrect chemistry. This process will create
unnatural colors and high contrast.
Preset Icons: Quick automation of popular cross processes.
Presets: A drop-down menu with a selection of cross process presets.
Styles: A drop down list of all color styles.
Amount: Controls the overall strength of the filter.
Brightness: Adjusts the overall brightness.
Contrast: Adjusts the overall contrast.
Saturation: Adjusts the underlining saturation.
Reset will return the settings to the default.
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Dynamic Contrast
Dynamic contrast adds clarity or tonal contrast to your image making the image pop.
Preset Icons: Presets for quick adjustments.
Preset: A drop-down menu with a fill list of dynamic contrast presets.
Detail Small: Adjusts contrast in small areas.
Detail Medium: Adjusts contrast in medium areas.
Detail Large: Adjusts the contrast in large areas.
Auto: Sets the black and white points automatically.
Highlights: Recovers detail in the highlights.
Shadows: Recovers detail in the shadows.
Whites: Increases the white contrast.
Blacks: Increases the black contrast.
Vibrance: Adjusts the vibrance of muted colors.
Reset will return the settings to the default.

Glow
This filter adds a soft focus glow to the image.
Preset Icons: Presets for quick adjustments.
Preset: A drop-down menu with a list of glow presets.
Amount: Controls the overall strength of the glow.
Halo: Sets the fuzziness or radius of the glow.
Style: A drop-down menu to set the style or blending.
Warmth: Controls the temperature of the glow.
Saturation: Adjusts the saturation of the image.
Reset will return the settings to the default.
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Grunge
This filter is used to add a dirty or grungy look to your image. Its great for urban exploration or
even senior portraits.
Preset Icons: Presets for quick adjustments.
Preset: A drop-down menu with a list of grunge presets.
Amount: Adjusts the overall strength of the grunge.
Brightness: Adjusts the overall brightness of the image.
Saturation: Adjusts the underlying saturation.
Detail: Adjusts the amount of detail.
Glow Amount: Adds a glow to the grunge.
Glow Style: A drop-down of glow styles or blending.
Film Grain Amount: Adds film grain to the image.
Film Grain Size: Controls the grain size.
Reset will return the settings to the default.

HDR Look
This filter recreates the HDR style of tone mapping.
Preset Icons: Presets for a quick adjustment.
Preset: A drop-down menu with a list of HDR presets.
Compression: Compresses the tone to reveal highlight and shadow detail.
Detail: Increases the local contrast.
Clarity: Increases the global contrast.
Highlights: Recovers detail in the highlights.
Shadows: Recovers detail in the shadows.
Vibrance: Adjusts the vibrance of muted colors.
Glow: Adds a bright glow.
Grunge: Adds a dark gritty look.
Reset will return the settings to the default.
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Lens Blur
This filter is the replacement for FocalPoint. It creates a blur, based on a camera lens such as a tiltshift or a shallow depth of field look.
Preset Icons: Presets for a quick adjustment.
Amount: Adjusts the overall strength of the blur.
Optic Quality: Controls the aperture shape in the inner and outer feather.
Motion: Adds motion to the blur.
Motion Type: A drop-down for selecting a motion type.
Angle: Sets the direction of the motion blur.
Sides: Sets the number of blades in the lens aperture changing the shape of the bokeh.
Curvature: Sets the curvature of the aperture blades.
Blooming: Adjusts the highlight bokeh.
Brightness: Controls the overall brightness of the blur.
Contrast: Controls the contrast of the blurred areas.
Film Grain: Adds simulated film grain to the blurred areas.
Reset will return the settings to the default.
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Photo Filter
This filter recreates solid color filters like warming and cooling. It also creates gradient filters like
neutral density and bicolor filters. Bicolor filters are different colors on each side of a divide. Each
filter offers different options.
Below are examples of these types of filters.

Graduated and Bi-Color

Here are the filter options:
Filter: A drop-down menu with filter presets.
Filter Icons: Sets the filter type; Solid, graduated or bi-color, center.
Colors: Color wells for setting the filter color.
Strength: Sets the strength, or opacity of the filter.
Saturation: Adjusts the saturation of the underlying image.
Position: These are controls for adjusting the position, rotation and transition (hardness).
Mode: Sets the blending mode.

Center

Graduated and Bi-Color
Presets: Selects the filter position on the image.
Distance: Adjusts the edge of the filter position.
Rotation: Adjusts the filter rotation or angle.
Transition: Adjusts the hardness of the feather.
Center
Transition: Adjusts the hardness of the feather.
Size: Adjusts the size of the center spot.
In/Out: Inverts the filter.
Reset will return the settings to the default.

Portrait Enhancer
The Portrait Enhancer is used to reduce blemishes, smooth skin and reduce shine on skin.
Preset: Presets for quick adjustments.
Blemishes: Adjusts the strength of acnes, pores and fine lines.
Smoothing: Adjusts the strength of smoothing similar to makeup foundation.
Shine: Adjusts the strength of the skin shine.
Skin Color: Use the Color Dropper icon to select the skin color. Click the icon to activate it
and single click again on the color of the skin in the image.
Color Well: This will display the color you have chosen, if you click on the box it will bring
up a color picker.
Range: Adjusts the precision of the color selected.
Reset will return the settings to the default.
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Sharpening
The sharpening filter adds a touch of sharpness to compensate for a moving subject, out of focus
camera or for an illustrative effect.
Preset Icons: Presets for quick adjustments.
Preset: A drop-down menu of Presets.
Type: A drop-down menu of the sharpening types. High-Pass, Progressive and

Unsharp Mask. Each sharpening method has its own set of sliders.
Amount: Controls the overall strength of the sharpening.
Radius: Sets the radius of the sharpening.
Detail: Controls the small details.
Protection: Protects tonal areas such as skies.

High-Pass

Reset will return the settings to the default.

Progressive

Unsharp Mask

Split Tone
This filter was formally known as Duotone. It is a gradient map that tints the dark and light portions
of the image in different hues. This is used to age an image and give it an antique or vintage look.
Preset Icons: Preset for quick adjustments.
Preset: A drop-down menu of all Split Tone presets.
Highlights Color: Use the Color Well icon to launch the color picker.
Highlights Amount: Controls the strength of the color selected on the highlights.
Shadows Color: Use the Color Well icon to launch the color picker.
Shadows Amount: Controls the strength of the color in selected on the shadows.
Swap Colors: Swaps the Highlight and Shadow colors.
Balance: Adjusts the balance between the shadow and highlight colors.
Mode: Sets the blending mode for the split tone.
Reset will return the settings to the default.
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Sunshine
This Filter increases the appearance of sunshine. It makes a flat cloudy day more vivid.
Preset Icons: Presets for quick adjustments.
Preset: A drop-down menu of all the Sunshine presets.
Amount: Controls the overall strength of the Sunshine.
Warmth: Adjusts the temperature.
Saturation: Adjusts the the vibrance or saturation.
Glow: Adds a bright glow to the image.
Reset will return all the settings to the default.

Texturizer
This filter places a texture over the image to add a stylized look. When loading a texture file, it will
be rotated automatically to match the orientation of the destination image layer. The user can
override the rotation with the rotate and flip tools.
Preset: A drop-down menu of all the Texture presets.
Category: Sets the category.
Texture: Selects the specific texture type.
Mode: Sets the blending mode for the texture.
Opacity: Sets the strength or opacity.
Hue: Adjusts the Hue of the texture.
Saturation: Controls the saturation of the texture.
Brightness: Adjusts the brightness of the texture.
Scale: Changes the size of the texture.
Rotate & Flip Icons: Rotates or flips the texture.
Reset wil return all the setting to the default.
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Tone Enhancer
The tone enhancer controls the brightness and contrast, or tone of the image.
Preset: A drop-down menu of all the Tone Enhancer Presets.
Brightness: Adjusts the global brightness.
Contrast: Adjusts the global contrast.

Shadows: Lightens the shadows to recover detail.
Highlights: Darkens the highlights to recover overexposed areas.
Compression: Compresses the tonal scale.
Auto: When enabled, this sets the black and white clipping points automatically, improving
the contrast range.
Whites: Sets the white clipping amount.
Blacks: Sets the black clipping amount.
Detail: Increases the local contrast in the image.
Clarity: Enhances large edges to add clarity.
Curves: The curves dialog is a powerful, advanced tool for adjusting contrast and color.
Reset will return all the settings to the default.

Vignette
The vignette control allows the user to darken or lighten the edges of the image.
Preset Icons: Presets for quick adjustments.
Presets: A drop-down menu of all the Vignette presets.
Brightness: Controls how light or dark the vignette is.
Size: Controls the size of the midpoint of the gradient.
Feather: Controls the hardness of the edge of the vignette.
Roundness: Controls the shape of the vignette square to round.
Style: This drop down menu will allow you to select either a normal, subtle or soft vignette.
Center Tool: This tool allows you to select the center point of the vignette. Click on the
tool icon to activate and then click on the area in the image you wish to make the center.
Reset will return all the setting to the default.
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Vintage
The vintage filter is for adding an aged, vintage look reminiscent of films and papers for the late
20th Century.

Preset Icons: Presets for quick adjustments.
Preset: A drop-down menu of all the Vintage presets.
Style: A drop-down menu of various color styles.
Amount: Controls the overall strength.
Saturation: Adjusts the saturation of the original image.

Film Grain Amount: Adds film grain to the image.
Film Grain Size: Controls the grain size.
Reset will return all the settings to the default.
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Using the Masking Tools
Perfect Effect users can choose the Masking Brush or Masking Bug to selectively apply each filter to the image. This opens a whole new world of control for
Perfect Effects. Using the Masking tools is just like using a layer mask in Photoshop to hide or reveal the filter in specific, user-defined areas of the image. The
Masking tools even support pressure-sensitive Wacom tablets for the ultimate in control.
You can think of masking as painting with black paint on white
paper.
A white mask reveals all the filter that the mask is attached to.
An all white mask is considered blank or empty and shows all
the selected filter. As you use the masking tools, you are
adding black paint (Paint-Out mode). Where you paint with
black you are hiding the current filter, allowing the filter(s)
under it to show through. Think of it like cutting a hole in the
mask. If you make a mistake, you can switch your paint color to
white (Paint-In mode) and paint the filter back in like an eraser.
When you paint you have more than just white or black, but
any shade of gray in between depending on the opacity of the
brush. Shades of gray partially hide the layer, blending the
layers together.
Each filter layer in Perfect Effects has a mask automatically
added to it. This allows you blend each filter differently.
There are several global masking options that can be accessed
from either the masking Tool Option Bar or the Masking Menu.
They affect the entire mask on the selected filter layer.

Reset Mask
Reseting a mask returns it to all white. The entire layer is
visible.

Invert Mask
Invert swaps the white for black and black for white. What was
hidden is now revealed and vice-versa. Inverting a mask can be
very useful. It allows you to paint a layer in, rather than out,
which is handy if you only want to work with a small area.

Copy and Paste Mask
Perfect Effects allows you to copy the mask from one filter
layer to another. This is handy if you have painted a complex
mask on one layer for an adjustment and you wish to use the
same mask on another layer for a different adjustment. To
copy or paste a mask, use the Copy Mask and Paste Mask
commands from the Masking menu.

Paint-In Effects
Some of the filters in Perfect Effects are designed to be painted-in. When you add them to your
image, you will not see the image change, but the Masking Brush will be selected automatically.
Simply paint where you would like the filter to be applied.
You can identify Paint-In filters by the paint-brush icon in the upper left corner of the thumbnail.
Most of the Paint-In filters are located in the Basic Brushes category.
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Mask Modes
Mask Mode allows you to view your image mask in several ways.

The drop-down menu for Mask View Mode is located at the bottom of
the Preview Window.

A close-up of the Mask View Modes

Before: Shows the original image with no effects applied.
After: Shows the image with the current effect stack applied.
Previous Effect: Shows the previous effect results so you can compare
just your current effect.
Mask-Red: Shows the mask of the current effect layer in a red overlay.
Mask-White: Shows the mask of the current effect layer in white.
Mask-Dark: Shows the mask of the current effect layer in as a dark
overlay.
Mask-Grayscale: Shows the mask of the current effect layer in black
and white.

Mask View allows you to view the mask for each effect layer that you have created with the Masking Brush and Masking Bug. You can view the mask in several
modes, which are accessible from the Masking menu or from the Mask View drop-down in the bottom left of each preview pane. Below are examples of the
different mask view modes. You can toggle the mask view on and off with the control (Mac OSX) or control (Windows) + M keyboard shortcut.

MaskRed
The
masked
area
appears as
50% red.
This is
similar to
the Quick
Mask view
in
Photoshop.

MaskDark
The
masked
area
appears as
90% black.

MaskWhite
The
masked
area
appears as
solid white.

MaskGrayscale
The
masked
area
appears as
black. The
unmasked
areas
appear as
white. This
is the same
as viewing
a layer
mask in
Photoshop.
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Using the Masking Brush
The Masking Brush: The Masking Brush functions like a brush tool for masking layers.

The Masking Brush is one of two tools in Perfect Effects
for masking filters. When you select the Masking Brush,
your tool icon changes to a circle that represents the size
of the brush. It may also appear as two concentric circles
(see below), indicating the inner hard edge and outer soft
edge of the brush if the feather control is set above zero.
There is also either a plus or minus in the center of the
brush. Minus means the brush mode is set to paint-out,
plus means it is set to paint-in.
How to use the Masking Brush
To use the Masking Brush, select it in the tool well. Make sure you are on the effect you wish to hide. Then check your brush mode and confirm it is set to
Paint-Out. You are ready to mask now, simply paint on the image in the areas you wish to hide. As you brush, you will see the underlying effect(s) appear. If
you make a mistake while brushing you have several options to correct them:
First you can use the Undo command from the edit menu. This will undo the last brush stroke you created.
You can toggle the paint mode to Paint-In and brush over your mistake.
How to control the Masking Brush
The Masking Brush Tool Options Bar

Paint Mode
The paint mode controls is you are Painting-Out (hiding the effect) or Painting-In (restoring the effect). You can tell your current mode by looking at the plus
or minus icon in the center of the brush. If the icon is minus, you are painting out. If the icon is a plus, you are painting-in. You can change the mode in the
Tool Options Bar, or by pressing the X key, or by holding down the option (alt) key temporarily.
Invert Mask
Invert swaps the hidden areas for the visible areas. What was hidden is no revealed and vice-versa. Inverting a mask can be very useful. It allows you to
paint a layer in, rather than out, which is handy if you only want to work with a small area. You can invert the mask by pressing the Invert button in the
Tool Options Bar.
Reset Mask
Reseting a mask reveals the entire layer it is associated with. You can reset the mask by pressing the Reset button in the Tool Options Bar.
Erase Brush Strokes
This is a special mode used when retouching the mask created by a Masking Bug. It allows you to erase your brush strokes made with the Masking Brush
while maintaining the mask from the Masking Bug.
Brush Size
You can control the size of the brush using the Size popup in the Tool Options Bar. You use a small brush at high
magnification for precise work, and a large brush at fit to
screen for general work. To the right, you can see
examples of brush strokes at varying sizes. You can
control the size of the brush several ways:
Use the Size pop-up in the Tool Options Bar.
Use the left and right bracket keys ( [ ] ).
Use the mouse scroll wheel (preferences must be
set to this).
Use your Wacom pressure sensitive tablet.
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Feather
You control the amount of feathering or hardness of the
brush by using the Feather pop-up in the Tool Options
Bar. The feather has a range from 1 to 100 percent. You
use a small feather at high magnification for precise,
hard-edged work and a large, soft-edged brush at fit to
screen for general work. You can visually see your
feather by watching the outer concentric circle of the
brush tool. To the right you can see examples of different
feather options. You can control the size of the brush
several ways:
Use the Feather pop-up in the Tool Options Bar.
Use the shift + left and right bracket keys ( [ ] ).

Opacity
You can control the opacity, or strength of the brush with
the Opacity pop-up in the Tool Options Bar. Think of the
opacity as the shade of gray you are painting with. The
opacity has a range from 1 to 100 percent. You use a
high opacity to paint quickly and hide large areas. You
use a lower opacity for blending areas together or for
subtle work. To the right you can see examples of
different opacity options. You can control the size of the
brush several ways:
Use the Opacity pop-up in the Tool Options Bar.
Use the option (Mac OSX) or alt (Windows) + 0-9
keys.
Use your Wacom pressure sensitive tablet.

Wacom® Controls
Perfect Layers supports pressure sensitive Wacom
tablets. When you use the Masking Brush you can enable
pressure sensitive controls for the brush size, brush
opacity, or both simultaneously. Click on the W button
next to each control in the Tool Options Bar to activate
the pressure sensitive controls.
The harder you press; the greater the size or opacity will
get. You can set the maximum value you want to use the
Brush Size and Opacity sliders. To the right you can see
examples of how pressure sensitivity can be used to
control the Masking Brush.
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Perfect Brush
The Perfect Brush option enables a unique, color-based,
self masking technology. When enabled, as you paint
with the Masking Brush it collects the colors under the
center of the brush and only masks those colors. This
protects the mask from being applied across edges. A
great of example of using the Perfect Brush option would
be to mask a sky along a horizon of mountains.
Tip: You can turn the Perfect Brush on and off
using the command or control -r keyboard
shortcut. You can also temporarily lock the color
to remove by holding down the control key(win)
or the command key(mac). This is useful when
brushing through areas with a lot of openings
like tree branches.
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Using the Masking Bug

Masking Bug: This is used for blending layers by creating Radial, gradient, and reflected gradient mask shape quickly.

The Masking Bug is perfect for tasks like darkening skies, creating vignettes and graduated filters. Learning to use the Masking Bug is fast and easy. All the
adjustments made with the Masking Bug are live and readjustable until you press apply.

Masking Bug Tool Options

The Tool Options Bar for the Masking Bug includes the options shown above and detailed here:
Preset: The preset pop-up includes several common ways to use the Masking Bug. These presets change the current Masking Bug to match the preset
Shape: The shape pop-up controls the shape of the Masking Bug. The shapes are center, edges, gradient and reflected gradient.
Opacity: Sets the maximum opacity or density of the mask.
Add: Adds a new Masking Bug using the current settings.
Delete: Deletes the current Masking Bug
Reset: Resets the mask on the layer completely. This removes all Masking Bugs and clears and brushing that has been done.
Adjusting the Masking Bug
Start by adding a Masking Bug to a layer by clicking on it or pressing the Add button. Then set the Mask View mode to Mask - Grayscale. This will let you
see the Masking Bug in simple black and white.
Move: Click the large circle and drag.
Size: Adjust the size of the masking bug by using the solid line
Feather: Use the dashed line to adjust the feather or hardness of the mask.
Rotate: The handle of the center circle will rotate the mask.
Reflected Gradient

Gradient

Center

Edges
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Working with Multiple Masking Bugs
You can use up to six Masking Bugs per layer. Each Masking Bug is re-editable
until you hit Apply and save your image. To add another Masking Bug, to create
a complex mask shape, press the Add button or click outside of the current
Masking Bug while the Masking Bug tool is selected.
Only one Masking Bug may be adjusted at a time. This is the active Masking Bug.
You will see the overlay controls for the active Masking Bug while your mouse is
over the preview area. Inactive Masking Bugs are marked with a small circle. You
can select an inactive Masking Bug by clicking on this small circle marker.
Masking Bugs are subtractive. Each Masking Bug hides more and more of the
current layer. When Masking Bugs overlay each other they may hide more of the
layer too. You can always use the Masking Brush to over-ride and paint areas
back in hidden by the Masking Bugs.
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Presets
Presets store the Effect Stack and all of the settings you can adjust in the the control panels on the right. Presets are a fast and easy way to get consistent
results. You can save your own presets for batch processing or for simply reproducing your look when retouching.

Using a Preset
Using a preset is simple, just click on it in the Preset Browser.

Saving a Preset
Saving a preset is simple. Once you have your settings that you wish to
save, go to the Preset menu and select Save Preset.
The New Preset dialog will appear (shown to the right). There are several
fields to complete including the preset name, the category, creator and
description.
In the category pull-down you can select which existing category the
preset should saved into. You can also create a new category this way by
selecting new category from the bottom of the list.
You can edit a preset's name, creator or description by selecting
it and then selecting Edit Preset Info from the Preset menu. If
you want to edit the settings in a preset, load it into, make your
adjustments and then re-save the preset with the same name
and location.

Deleting a Preset
You can remove a preset from Perfect Effects if you no longer want to
have access to it. To remove a preset, follow these steps:
1. Open Perfect Effects.
2. Select the preset you wish to remove in the preset browser.
3. Select Delete Preset from the Preset menu.

Importing & Sharing Presets
You can import presets you have downloaded from the onOne website
using these steps.
1. Download the preset pack from the onOne website. It should have
a .ONPreset extension.
2. Double-click on the preset pack, it will install the presets into a
category named the same as the preset pack.
That's it, next time you use Perfect Effects the new presets will be located
in the My Presets tab, in a category named after the preset pack. You can
delete the files you downloaded, they have been copied into Perfect
Effects.
You can share presets like you would share any other file, such as email or
posting them to a website. First you need to find the preset files. The
easiest way it to open Perfect Portrait, then from the Preset menu select
Show Presets Folder. A Finder (Mac) or Explorer (Win) window will open
and will display the presets folder. In the presets folder are sub-folders for
your preset categories. Inside each sub-folder are the individual preset
files, with a .ONEffects extension. You can copy these presets to another
computer, attach them to an email or post them on a website.
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Menus
Perfect Effects
About Perfect Effects: Opens the about box. This dialog contains your serial
number, version number and information on contacting onOne Software for
support.
Preferences: Opens the preferences dialog.
Quit: Quits the application.

File
Save & Close: Applies the current effect Stack and options to your image and
returns to the host application.
Cancel: Cancels Perfect Effects and returns back to the host application with no
changes.

Edit
Undo: Reverses the last user action.
Redo: Reapplies the last user action if it has been undone.
Cut: Cuts the current text into the clipboard.
Copy: Copies the current text into the clipboard.
Paste: Pastes the content of the clipboard.
Reset All: Resets all the floating palette controls back to their default settings.
Preferences (Windows Only): Opens the Perfect Effects preferences dialog.

Mask
Invert Mask: Inverts the mask, what was hidden is revealed and vice versa.
Reset Mask: Resets the mask to plain white.
Copy Mask: Copies the mask.
Paste Mask: Pastes the mask.
Masking Bug Tool Opacity: Sets the opacity of the Masking Bug tool overlay.
This has no effect on the image, just how obvious the Masking Bug tool is on
screen.
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Preset
Save Preset: Saves the current Effect Stack as a new preset.
Import Preset: Opens the import preset dialog to help you import presets you
have downloaded.
Show Presets Folder: Opens a Finder or Explorer window showing the
presets folder.
Delete Preset: Deletes the current preset.
Edit Preset Info: Opens the preset dialog so you can edit the name, author or
description information.
Manage Extras: Opens the Extras Manager where you can import and
manage extras like Borders, Backgrounds, Textures and Presets.

View
Zoom In: Zooms the preview window in one increment. This will make the
preview image larger.
Zoom Out: Zooms the preview window out one increment. This will make the
preview image smaller.
Fit to Screen: This sets the preview image so that the entire image is on
screen at once. Think of this as an overview of the entire image. This is the
setting you will use most of the time.
Actual Pixels: This sets the preview image so that it zooms to actual pixels or
1:1 also called 100%. This setting allows you to see every pixel in the image.
This is useful when making precision adjustments.
Show Browser Pop-up: Enables the browser pop-up window.
Select Filter Automatically: This will apply the first filter in each category
automatically.
Browser Mode: Allows the user to select how the Browser Library displays the
categories.
Show Clipping: Shows the clipping overlay view, which over-rides
the current mask view.
Show Preview: Toggle to enable or disable the preview.
Preview Mode: Allows the user to switch preview modes.
Preview Background Color: Toggles the background color options.
Show Mask: Allows the viewer to see the mask.
Mask View Mode: Allows the user to select the various mask modes.

Window
Navigator/Loupe/Histogram: Hides or shows the Navigator, Loupe/
Histogram pane.
Filter Stack: Hides or shows the Filters Stack pane.
Filter Options: Hides or shows the Filter Options pane. Filter Options is only
available in Advanced mode.
Open Quick View Browser: This toggles open your quick view browser.
Show Browser Panel: Hides or shows the Browser Panel.
Show Control Panel: Hides or shows the Control Panel.
Hide Panels: Hides or shows all Panels.
Full Screen: Toggles to and from full screen mode.
Document Name: Shows the name, zoom level and bit depth of the open
image.
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Help
Search: Mac OSX only. Searches the menus options.
Perfect Effects Online Help: Opens this html Help in your default web
browser.
Video Tutorials: Opens the online Video Tutorial in your default web browser.
Getting Started: Opens the getting started overlay.
Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.
Perfect Inspiration: Takes you to the Perfect Inspiration web site.
Check for Updates: Checks with the onOne update server to see if you are
running the current version. If there is a newer version you will be notified and
be walked through the update process.
Deactivate: Opens the activation dialog. These are used to deactivate your
software for moving it to another computer or for a return.
Registration: Opens the default web browser and navigates to the
registration page of the onOne website.
Provide Feedback: Opens the default web browser and navigates to the
feedback page of the onOne website.
About Perfect Effects (Windows Only): Opens the about box with the
version number and license code displayed.
Help Improve onOne Products: Opens the Improve onOne Products dialog.
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Keyboard Shortcuts
Perfect Effects has many keyboard short-cuts to make it faster to access common buttons and menu items. It also uses many of the keyboard shortcuts that
Photoshop uses, making it intuitive to learn. Here is a list of the most commonly used keyboard shortcuts:

Action

Mac

Apply

return

Win
return

Cancel

esc

esc

Undo

cmd z

ctl z

Redo

cmd shift z

ctl shift z

Cut

cmd x

ctl x
ctl c

Copy

cmd c

Paste

cmd v

ctl v

Invert Mask

cmd i

ctl i

Save Preset

cmd shift s

ctl shift s

Zoom In

cmd +

ctl +

Zoom Out

cmd -

ctl -

Fit to Screen

cmd 0

ctl 0

Actual Pixels

cmd opt 0

ctl alt 0

Next Browser View Mode

cmd b

ctl b

Show Clipping

opt j

alt j

Show Preview

cmd p

ctl p

Preview Modes
- Single Image
- Left/Right
- Left/Right Split
- Top/Bottom
- Top/Bottom Split

cmd Y
cmd L
cmd opt L
cmd T
cmd opt T

ctl Y
ctl L
ctl opt L
ctl T
ctl opt T

Show Mask

ctl m

alt m

Navigator/Loupe/Histogram

cmd 1

ctl 1

Filter Stack

cmd 2

ctl 2

Filter Options

cmd 3

ctl 3

Show Browser Panel

cmd left arrow

ctl left arrow

Show Control Panel

cmd right arrow ctl right arrow

Hide Panels

tab

tab

Fullscreen Mode

cmd ctl f

F11

Keyboard Shortcuts

cmd shift k

ctl shift k

Select Masking Brush

b

b

Select Masking Bug

m

m

Select Hand Tool

h

h

Select Zoom Tool

z

z

Zoom-In

cmd +

ctl +

Zoom-Out

cmd -

ctl -

Actual Pixels

cmd opt 0

ctl alt 0

Fit to Screen

cmd 0

ctl 0

Toggle Perfect Brush

cmd r

ctl r

Brush Size

larger ]
smaller [

larger ]
smaller [

Brush Feather

softer shift ]
harder shift [

softer shift ]
harder shift [

Brush Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc or
opt ]
opt [

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc or
alt ]
alt [

Enable or Disable Perfect Brush cmd r

ctl r

Toggle Tool Mode

x

x
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Temp Select Hand Tool

spacebar

spacebar

Temp Toggle Tool Mode

hold opt

hold ctl

Temp Toggle Clipping View

j

j

Preview on/off

cmd p

ctl p

Show Quick View Browser

cmd up

ctl up
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